
USER GUIDE

NI SMB-2163
Single-Ended Digital I/O Accessory

The NI SMB-2163 is a breakout box for National Instruments single-ended 
digital waveform generator/analyzer modules. The NI SMB-2163 provides 
an easy way to connect to other devices for testing and debugging.

This guide explains how to set up and use the NI SMB-2163 single-ended 
digital I/O (DIO) accessory with NI single-ended digital waveform 
generator/analyzer modules.
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Conventions
The following conventions are used in this manual:

<> Angle brackets that contain numbers separated by an ellipsis represent a 
range of values associated with a bit or signal name—for example, 
DIO <0..3>.

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash. When this symbol is marked on a 
product, refer to the Specifications section for information about 
precautions to take.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 
to a key concept. This font also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames, and extensions.

What You Need to Get Started
To set up and use the NI SMB-2163, you need the following items:

❑ SHC68-C68-D2 cable assembly

❑ NI digital waveform generator/analyzer, installed in a PXI 
or CompactPCI chassis

❑ 50 Ω cables with SMB connectors
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❑ The documentation included with the digital waveform 
generator/analyzer and driver software

❑ (Optional) Rack Mount Kit for CA-1000 (part number 777665-01), 
available from National Instruments

Related Documentation
The NI digital waveform generator/analyzer ships with several documents 
designed to familiarize you with different aspects of the module. The 
documentation set includes the following pieces:

• NI Digital Waveform Generator/Analyzer Getting Started 
Guide—Read this printed document to set up the digital waveform 
generator/analyzer and configure it to complete your first acquisition 
or generation.

• NI Digital Waveform Generator/Analyzer Help—This online 
document provides more in-depth information about the hardware 
capabilities of the module, theory of operation, programming flow, 
and software reference.

• NI digital waveform generator/analyzer specifications—This printed 
document provides specifications for your module.

Parts Locator
Refer to Figure 1 to locate connectors on the NI SMB-2163.

Figure 1.  NI SMB-2163 Parts Locator Diagram
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Installing Cables
Complete the following steps to install the NI SHC68-C68-D2 cable and 
any 50 Ω SMB cables.

Caution Disconnect power from the device, accessory, and any other connected hardware 
before connecting the cable to prevent damage to the hardware and personal injury. NI is 
not liable for damage resulting from improper connections.

1. Install the driver software and digital waveform generator/analyzer 
by following the installation procedure in the NI Digital Waveform 
Generator/Analyzer Getting Started Guide.

Note Always install the module in a computer or PXI/CompactPCI chassis before 
attaching any cables or accessories. 

2. Attach either end of an NI SHC68-C68-D2 cable assembly to the DDC 
connector of the digital waveform generator/analyzer and secure the 
cable with the captive screws on the cable connector.

Notes Do not use cables other than the NI SHC68-C68-D2 cable with this accessory.

Do not use the NI SMB-2163 accessory with differential digital signals, such as the digital 
pattern output of the NI PXI-5421 signal generator.

The NI SMB-2163 is not compatible with the NI 6533/6534 products.

3. Attach and secure the other end of the NI SHC68-C68-D2 cable 
assembly to the DDC connector of the NI SMB-2163 and secure them 
together with the captive screws on the cable connector.
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Figure 2 shows how the NI SHC68-C68-D2 cable connects the 
NI SMB-2163 and the NI digital waveform generator/analyzer.

Figure 2.  Connecting a Single-Ended Digital Waveform Generator/Analyzer 
to the NI SMB-2163

4. Make signal connections by connecting SMB cables to NI SMB-2163 
signal terminals.

Note To ensure a solid ground connection, tighten the SMB connectors by gently 
snapping them into place.
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Connecting Signals
The NI SMB-2163 provides connectivity to up to 32 single-ended DIO 
channels, three programmable function interface (PFI) channels, and 
two clock channels of an NI digital waveform generator/analyzer. You 
can connect to these signals from the labeled SMB connectors on the 
NI SMB-2163.

Caution Connections that exceed any of the maximum ratings for the NI SMB-2163 
or the NI digital waveform generator/analyzer can damage the device and the computer. 
Maximum input ratings are provided in the specifications document that shipped with the 
NI digital waveform generator/analyzer. NI is not liable for any damages resulting from 
such signal connections.

Figure 3 shows the pinout of the DDC connector of the accessory. Each 
DIO, PFI, and clock channel is connected to a corresponding pin on the 
NI SMB-2163.

Table 1 describes the DDC signals in the pinout.
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Figure 3.  DDC Connector Pinout

Note Refer to the NI Digital Waveform Generator/Analyzer Help at Program 
Files»National Instruments»NI-HSDIO»Documentation»NI Digital Waveform 
Generator/Analyzer Help for information about the number of available DIO channels 
on your device. DIO <20..31> may not apply to your device.
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Note For additional shielding, you can connect the shield ground connector on the 
NI SMB-2163 to earth/hard ground. This terminal is connected to the shielded enclosure 
ground. The shield ground lug is shown in Figure 1.

Cleaning the Accessory
Disconnect all cables to the NI SMB-2163 before cleaning. To remove 
light dust, use a soft, nonmetallic brush. To remove other contaminants, use 
alcohol wipes. The unit must be completely dry and free from contaminants 
before returning to service.

Table 1.  DDC Connector Pinout Descriptions

DDC Pin Signal Description

DIO <0..31> Bidirectional digital data channels 0 though 31.

STROBE External Sample clock source for pattern 
acquisition.

DDC CLK OUT Exported Sample clock signal.

PFI <1..3> Programmable function interface channels 
1 through 3.

GND Ground reference for signals.

RESERVED These channels are reserved for system use. 
Do not connect signals to these channels.
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Specifications

Digital I/O
DIO channels.......................................... 32, single-ended

Control I/O channels .............................. 5, single-ended

Typical propagation delay 
through NI SMB-2163 ........................... 1.2 ns

Typical channel-to-channel skew........... ±35 ps

Typical trace 
characteristic impedance ........................ 50 Ω

Power
Maximum voltage rating........................ 5.5 V

Physical
Dimensions............................................. 30.5 cm × 4.5 cm × 26.5 cm

(12.0 in. × 1.77 in. × 10.43 in.)

I/O connectors ........................................ One 68-pin DDC connector, 
37 SMB jack connectors, 
one banana-style connector

CE Compliance
Refer to the regulatory statement for this product for additional 
compliance information. To obtain this information for this product, 
visit ni.com/hardref.nsf, search by model number or product line, 
and click the appropriate link in the Certification column.

Caution When connected to other test objects, this product may cause radio interference. 
In a residential environment, the user may be required to take adequate measures to reduce 
the radio interference.
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Environmental Management
National Instruments is committed to designing and manufacturing 
products in an environmentally responsible manner. NI recognizes that 
eliminating certain hazardous substances from our products is beneficial 
not only to the environment but also to NI customers.

For additional environmental information, refer to the NI and the 
Environment Web page at ni.com/environment. This page contains the 
environmental regulations and directives with which NI complies, as well 
as other environmental information not included in this document.

Waste Electrical and Electronic Equipment (WEEE)
EU Customers At the end of their life cycle, all products must be sent to a WEEE recycling 
center. For more information about WEEE recycling centers and National Instruments 
WEEE initiatives, visit ni.com/environment/weee.htm.

Technical Support Resources

NI Web Support
National Instruments Web support is your first stop for help in solving 
installation, configuration, and application problems and questions. Online 
problem-solving and diagnostic resources include frequently asked 
questions, knowledge bases, product-specific troubleshooting wizards, 
manuals, drivers, software updates, and more. Web support is available 
through the Technical Support section of ni.com.

Worldwide Support
National Instruments corporate headquarters is located at 
11500 North Mopac Expressway, Austin, Texas, 78759-3504. 
National Instruments also has offices located around the world to help 
address your support needs. You can access our branch office Web sites 
from the Worldwide Offices section of ni.com. Branch office Web sites 
provide up-to-date contact information, support phone numbers, email 
addresses, and current events. 

RoHS
National Instruments  (RoHS)

National Instruments RoHS ni.com/environment/rohs_china
(For information about China RoHS compliance, go to ni.com/environment/rohs_china.)
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If you have searched the technical support resources on our Web site 
and still cannot find the answers you need, contact your local office or 
National Instruments corporate. For telephone support in the United States, 
dial 512 795 8248. For telephone support outside the United States, contact 
your local branch office: 

Australia 1800 300 800, Austria 43 662 457990-0, 
Belgium 32 (0) 2 757 0020, Brazil 55 11 3262 3599, 
Canada 800 433 3488, China 86 21 5050 9800, 
Czech Republic 420 224 235 774, Denmark 45 45 76 26 00, 
Finland 358 (0) 9 725 72511, France 01 57 66 24 24, 
Germany 49 89 7413130, India 91 80 41190000, Israel 972 3 6393737, 
Italy 39 02 41309277, Japan 0120-527196, Korea 82 02 3451 3400, 
Lebanon 961 (0) 1 33 28 28, Malaysia 1800 887710, 
Mexico 01 800 010 0793, Netherlands 31 (0) 348 433 466, 
New Zealand 0800 553 322, Norway 47 (0) 66 90 76 60, 
Poland 48 22 3390150, Portugal 351 210 311 210, Russia 7 495 783 6851, 
Singapore 1800 226 5886, Slovenia 386 3 425 42 00, 
South Africa 27 0 11 805 8197, Spain 34 91 640 0085, 
Sweden 46 (0) 8 587 895 00, Switzerland 41 56 2005151, 
Taiwan 886 02 2377 2222, Thailand 662 278 6777, 
Turkey 90 212 279 3031, United Kingdom 44 (0) 1635 523545



 

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation. Refer to the Terms of Use section on 
ni.com/legal for more information about National Instruments trademarks. Other product and company names mentioned herein are 
trademarks or trade names of their respective companies. For patents covering National Instruments products, refer to the appropriate location: 
Help»Patents in your software, the patents.txt file on your CD, or ni.com/patents.

© 2003–2007 National Instruments Corporation. All rights reserved. 373660D Nov07



ユーザガイド

NI SMB-2163
シングルエンドデジタル I/O アクセサリ

NI SMB-2163 は、ナショナルインスツルメンツのシングルエンドデジタ

ル波形発生器 / アナライザモジュールのブレークアウトボックスです。 
NI SMB-2163 を使用すると、テストおよびデバッグのために別のデバイ

スと接続することが簡単になります。

このガイドは、NI シングルエンドデジタル波形発生器 / アナライザモ

ジュールと、NI SMB-2163 シングルエンドデジタル I/O（DIO）アクセサ

リを設定および使用する方法について説明します。

目次
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仕様 ..................................................................................................................................... 9
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表記規則

本書では以下の表記規則を使用します。

<> 山括弧で囲まれた数字と省略記号（たとえば DIO<0..3> など）は、ビッ
トや信号名に関連する値の範囲を示します。

→ 矢印（→）は、ネスト化されているメニュー項目やダイアログボックスの
オプションをたどっていくと目的の操作項目を選択できることを示しま
す。 たとえば、ファイル→ページ設定→オプションとなっている場合は、
ファイルメニューをプルダウンして、ページ設定項目を選択し、最後のダ
イアログボックスからオプションを選択します。

このアイコンは、注意すべき重要な情報があることを示しています。

このアイコンは、人体への損傷、データの損失、システムのクラッシュな
どを防止するための注意事項があることを示しています。 製品にこの記号
が付いている場合は、「仕様」セクションで事前対策を確認してください。

太字 太字のテキストは、メニュー項目やダイアログボックスのオプションな
ど、ソフトウェアで選択またはクリックする必要がある項目を表します。 
太字のテキストは、パラメータ名も表します。

斜体 斜体のテキストは、変数、強調、相互参照、重要な概念の説明を示しま
す。 また、入力する必要のある言葉や値を表すこともあります。

monospace このフォントのテキストは、キーボードから入力する必要があるテキスト
や文字、コードの一部、プログラムサンプル、構文例を表します。 また、
ディスクドライブ、パス、ディレクトリ、プログラム、サブプログラム、
サブルーチンなどの名称、デバイス名、関数、操作、変数、ファイル名お
よび拡張子の引用にも使用されます。

使用を開始する前に

NI SMB-2163 の設定および使用には以下が必要です。

❑ SHC68-C68-D2 ケーブルアセンブリ

❑ PXIまたはCompactPCIシャーシに取り付けられたNIデジタル波形

発生器 / アナライザ

❑ 50 Ωケーブル（SMB コネクタ付き）

❑ デジタル波形発生器 / アナライザおよびドライバソフトに付属するド

キュメント

❑ （オプション）ナショナルインスツルメンツから購入可能な CA-1000
用ラックマウントキット（製品番号 777665-01）
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関連ドキュメント

NI デジタル波形発生器 / アナライザは数種類のドキュメントとともに出

荷されており、ユーザはモジュールのさまざまな機能が習得可能です。 
ドキュメントセットには以下が含まれます。

• 『NI デジタル波形発生器 / アナライザスタートアップガイド』: デジ

タル波形発生器 / アナライザの設定、および初めて集録または生成を

行うための構成については、この印刷版ドキュメントをお読みくださ

い。

• 『NI デジタル波形発生器 / アナライザヘルプ』: モジュールのハード

ウェア機能、動作理論、プログラミングフロー、およびソフトウェア

リファレンスの詳細が記載されています。

• NI デジタル波形発生器 / アナライザ仕様 : モジュールの仕様が記載さ

れています。

パーツ配置

NI SMB-2163 のコネクタの位置については、図 1 を参照してください。

図 1 NI SMB-2163 パーツ配置図

1 STROBE
2 DDC CLK OUT
3 DIO <0..31>

4 68 ピン DDC（Digital Data & Control）コネクタ

5 PFI（プログラム可能関数インタフェース） <1..3>
6 シールド接地端子
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ケーブルを取り付ける

NI SHC68-C68-D2 ケーブルおよび任意の 50 Ω SMB ケーブルを取り付け

るには、以下の手順に従ってください。

注意 ハードウェアの破損や身体の負傷を防止するため、ケーブルを接続する前にデ

バイス、アクセサリ、およびデバイスに接続されているその他のハードウェア

との電源を切断してください。 ナショナルインスツルメンツは、不適切な接続に

よる損傷の責任を負いません。

1. 『NI デジタル波形発生器 / アナライザスタートアップガイド』に記載

のインストール手順に従って、ドライバソフトウェアをインストール

し、デジタル波形発生器 / アナライザを取り付けます。

メモ モジュールは、ケーブルやアクセサリを取り付ける前に、コンピュータまたは

PXI/CompactPCI シャーシに取り付けてください。 

2. NI SHC68-C68-D2 ケーブルアセンブリの一端をデジタル波形発生器 /
アナライザの DDC コネクタに取り付け、ケーブルコネクタの取り付

けネジでケーブルを固定します。

メモ NI SHC68-C68-D2 ケーブル以外のケーブルをこのアクセサリと一緒に使用しな

いでください。

NI SMB-2163 アクセサリを、NI PXI-5421 信号発生器のデジタルパターン出力な

ど異なるデジタル信号と使用しないでください。

NI SMB-2163 は、NI 6533/6534 製品と互換性がありません。

3. NI SHC68-C68-D2 ケーブルアセンブリの他端を NI SMB-2163 の

DDC コネクタに取り付けて固定し、ケーブルコネクタの取り付けネ

ジで DDC コネクタとケーブルコネクタを固定します。
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図 2 は、NI SHC68-C68-D2 ケーブルが NI SMB-2163 および NI デジタル

波形発生器 / アナライザをどのように接続するかを示します。

図 2 シングルエンドデジタル波形発生器 / アナライザを NI SMB-2163 に接続する

4. SMB ケーブルを NI SMB-2163 信号端子に接続して、信号接続を作成

します。

メモ 接地接続が確実であることを確認するには、SMB コネクタを軽く押し込んで固

定します。
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信号を接続する

NI SMB-2163 は、最大 32 個のシングルエンド DIO チャンネル、3 つの

PFI（プログラム可能関数インタフェース）チャンネル、および 2 つのク

ロックチャンネルを NI デジタル波形発生器 / アナライザに接続できます。 
NI SMB-2163 のラベルの付いた SMB コネクタからのこれらの信号に接続

できます。

注意 NI SMB-2163 または NI デジタル波形発生器 / アナライザにおいて接続がいずれ

かの最大定格を超えると、デバイスおよびコンピュータが破損するおそれがあ

ります。 最大入力定格については、デジタル波形発生器 / アナライザに同梱の仕

様書に記載されています。 ナショナルインスツルメンツは、このような信号接続

による損傷の責任を負いません 。

図 3 は、アクセサリの DDC コネクタのピン配列を示します。 各 DIO、

PFI、およびクロックチャンネルは、NI SMB-2163 上にある対応する各ピ

ンに接続されています。
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表 1 は、ピン配列の DDC 信号の説明です。

図 3 DDC コネクタピン配列

メモ ご使用のデバイスで利用可能な DIO チャンネル数については、プログラム→

National Instruments → NI-HSDIO →ドキュメント→ NI デジタル波形発生器 /
アナライザヘルプを選択して、『NI デジタル波形発生器 / アナライザヘルプ』

を参照してください。 DIO <20..31> は、お使いのデバイスによっては適用され

ない場合があります。
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GND

DIO 21
GND

DIO 19
GND

DIO 17
GND

DIO 15
GND

DIO 13
GND

DIO 11
GND

DIO 9
GND

DIO 7
PFI 1
DIO 5
GND

DIO 3
PFI 3
DIO 1
GND

DDC CLK OUT
GND

DIO 30
GND
DIO 28
GND
DIO 26
GND
DIO 24
GND
DIO 22
GND
DIO 20
GND
DIO 18
GND
DIO 16
GND
DIO 14
RESERVED
DIO 12
GND
DIO 10
GND
DIO 8
GND
DIO 6
RESERVED
DIO 4
GND
DIO 2
PFI 2
DIO 0
GND
STROBE
GND
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メモ 追加のシールドについては、NI SMB-2163 上にあるシールドグランドコネクタ

をアース / ハードグランドに接続することができます。 この端子は、シールド

ケースグランドに接続されています。 シールド接地端子は図 1 に示されていま

す。

アクセサリを掃除する

掃除をする前に、NI SMB-2163 に接続されているケーブルをすべて取り

外します。 ほこりを取り除くには、柔らかな非金属のブラシを使用しま

す。 その他の汚れは、アルコールで拭き取ります。 動作させる前に、完全

に乾燥させ汚染物質が付着していないか確認します。

表 1 DDC コネクタピン配列の説明

DDC ピン 信号の説明

DIO <0..31> 双方向デジタルデータチャンネル、0 ～ 31。

STROBE パターン集録用の外部サンプルクロックソース。

DDC CLK OUT エクスポートしたサンプルクロック信号。

PFI <1..3> プログラミング可能関数インタフェースチャン
ネル、1 ～ 3。

GND 信号用グランド基準。

RESERVED これらのチャンネルはシステムが使用するため
に確保されています。 これらのチャンネルに信号
を接続しないでください。
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仕様

デジタル I/O
DIO チャンネル数 .......................................... 32、シングルエンド

制御 I/O チャンネル数.................................. 5、シングルエンド

標準伝播遅延 
NI SMB-2163 を介する場合 ........................ 1.2 ns

標準チャンネル間スキュー ......................... ±35 ps

標準実行トレース 
特性インピーダンス ...................................... 50 Ω

電源
最大定格電圧.................................................... 5.5 V

一般仕様
寸法 ..................................................................... 30.5 cm × 4.5 cm × 26.5 cm 

(12.0 in. × 1.77 in. × 10.43 in.)

I/O コネクタ .................................................... 68 ピン DDC コネクタ（× 1）、
SMB ジャックコネクタ（× 37）、
バナナコネクタ（× 1）

CE 適合
本製品の上記以外の適合指令に関する情報については、規制声明をご覧く

ださい。 この製品の適合宣言を入手するには、ni.com/certification

（英語）にアクセスして型番または製品ラインで検索し、該当するリンク

をクリックしてください。

注意 その他のテスト対象に接続すると、本製品は無線妨害を引き起こす原因となる

場合があります。 住宅環境では、ユーザは無線妨害を抑えるために適切な処置を

取る必要がある場合があります。

環境管理
ナショナルインスツルメンツは、環境に考慮した製品の開発および製造に

取り組んでいます。 NI は、製品から特定の有害物質を除外することが、

環境のみならず NI のお客様にとって有益であると考えています。

環境情報に関する詳細は、ni.com/environmentで NI and the 
Environment（英語）のウェブページをご覧いただけます。 このページに

は、NI が準拠している規制と規格や、このドキュメントには含まれてい

ない環境情報についてが説明されています。
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廃電気電子機器（WEEE）
欧州のお客様へ 製品寿命を過ぎたすべての製品は、必ず WEEE リサイクルセンターへ
送付してください。 WEEE リサイクルセンターおよびナショナルインスツルメンツの

WEEE への対応に関する詳細は、ni.com/environment/weee.htmを参照してくださ
い。

技術サポートのリソース

NI ウェブサポート
取り付け、構成、アプリケーションに関する問題やご質問は、まずナショ

ナルインスツルメンツのウェブサイトのサポートサイトをご利用くださ

い。 オンラインで入手できる情報には、よくある質問（FAQ）、技術サ

ポートデータベース、製品別トラブルシューティングウィザード、マニュ

アル、ドライバ、ソフトウェアアップデートなどがあります。 ウェブサ

ポートは、ni.com/jpの技術サポートからご利用いただけます。

世界各国のサポート
ナショナルインスツルメンツでは、米国本社（11500 North Mopac 
Expressway, Austin, Texas, 78759-3504）および各国の現地オフィスに

てお客様にサポート対応しています。 各国の現地オフィスのウェブサイト

には、ni.comの Worldwide Offices からアクセスできます。日本国内

のサポートについては、サービスリクエストを ni.com/jp/supportで

作成するか、03-5472-2970（大代表）までお電話ください。日本国外で

のサポートについては、各国の営業所にご連絡ください。 

上記のウェブサイトの技術サポートのリソースを検索しても回答が見つか

らない場合は、ナショナルインスツルメンツの最寄の営業所にご連絡くだ

さい。 アメリカ合衆国での電話サポートは 1 512 795 8248 までご連絡く

ださい。アメリカ国外での電話サポートについては各支店までお問い合わ

せください。 

イスラエル 972 3 6393737、イタリア 39 02 41309277、
インド 91 80 41190000、英国 44 0 1635 523545、 
オーストラリア 1800 300 800、オーストリア 43 662 457990-0、
オランダ 31 (0) 348 433 466、 カナダ 800 433 3488、
韓国 82 02 3451 3400、シンガポール 1800 226 5886、
スイス 41 56 2005151、 スウェーデン 46 (0) 8 587 895 00、
スペイン 34 91 640 0085、スロベニア 386 3 425 42 00、

RoHS
National Instruments  (RoHS)

National Instruments RoHS ni.com/environment/rohs_china
(For information about China RoHS compliance, go to ni.com/environment/rohs_china.)
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タイ 662 278 6777、台湾 886 02 2377 2222、中国 86 21 5050 9800、
チェコ 420 224 235 774、デンマーク 45 45 76 26 00、
ドイツ 49 89 7413130、 トルコ 90 212 279 3031、
ニュージーランド 0800 553 322、ノルウェー 47 (0) 66 90 76 60、
フィンランド 358 (0) 9 725 72511、フランス 01 57 66 24 24、 
ベルギー 32 (0) 2 757 0020、ブラジル 55 11 3262 3599、
ポーランド 48 22 3390150、 ポルトガル 351 210 311 210、 
マレーシア 1 800 887710、南アフリカ 27 0 11 805 8197、
メキシコ 01 800 010 0793、レバノン 961 (0) 1 33 28 28、
ロシア 7 495 783 6851



 

National Instruments、NI、ni.com、および LabVIEW は National Instruments Corporation
（米国ナショナルインスツルメンツ社）の商標です。National Instruments の商標の詳細については、
ni.com/legalの「Terms of Use」セクションを参照してください。本文書中に記載されたその他の
製品名および企業名は、それぞれの企業の商標または商号です。National Instruments の製品を保護
する特許については、ソフトウェアに含まれている特許情報（ヘルプ→特許情報）、CD に含まれている
patents.txtファイル、または ni.com/patentsのうち、該当するリソースから参照してください。
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